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1 Introduction
Thank you for purchasing Data Backup Pro, the easiest to use, full featured backup utility on the Mac OS platform.

This manual will help you get started, regardless of the level of experience you have using your computer.

Please continue reading from this point to get a little background information before you proceed.

Why backup?

You make documents, download files, install applications and keep your system up to date - all of these

activities add and change the data on your computer and many of them represent a significant amount of

your own time that you invest. The data on your computer is stored on a hard drive that is made up of many

mechanical moving parts. These hard drives, given enough time, are certain to fail - and when they do, it

may leave your data inaccessible. The best protection you can provide for yourself is to make additional

copies of your data and store them in a safe place.

What is a backup utility?

A backup utility is an application that allows you to copy a large amount of files conveniently and easily and

to find and restore those files when you need to. A backup utility should be the most important application on

your computer because it protects all the data that your acquire and create. Data Backup is the easiest to

use, full-featured backup utility available on the Mac platform.

Philosophy

Data Backup Pro was designed and built for ease of use and to be a powerful and reliable way to protect

yourself from losing valuable data. With Data Backup Pro, you can make a partial or complete backup with

just a few easy mouse clicks and repeat that backup process automatically at any time of your choosing.

Data Backup Pro safely copies your files between hard drives and folders within hard drives. Because Data

Backup Pro does not copy to tape drives, your data will be copied in Finder-readable format and can be

easily accessed in the future.

Table of Contents

file:///Applications/Data%20Backup.app/Contents/Resources/English.lproj/Help/pages/quickstart.htm
file:///Applications/Data%20Backup.app/Contents/Resources/English.lproj/Help/pages/quickstart.htm
file:///Applications/Data%20Backup.app/Contents/Resources/English.lproj/Help/index.htm
file:///Applications/Data%20Backup.app/Contents/Resources/English.lproj/Help/index.htm


   Introduction Using Data Backup Pro   Table of Contents

2 Quick Start
Your first backup

To perform a backup on your computer you must have a drive or CD/DVD media available that will accommodate all the data you are planning to copy. For instance,

if you are planning to perform a complete backup of your internal drive (this is your first recommended backup), you must have an external drive of adequate free

space to contain all of the data on your internal drive.

If you do not have a suitable backup drive, you can obtain one from most computer retailers (USB 3.0 or Thunderbolt drives are best for speed, but you may also use

a USB 2.0 or FireWire drive). Check the capabilities of your computer before purchasing a drive so that you are sure your computer and your new drive are

compatible with one-another.

Now, with your external drive attached, read on and get started with your first backup.

2.1 Install and start Data Backup Pro.

Installing Data Backup Pro

Data Backup Pro must first be installed on your computer before it can be used. When you purchased Data Backup Pro, you received a download containing an

installer application.

The install process just takes a few seconds and Data Backup Pro will be completely installed and the Data Backup Pro application will reside in your Application

folder. Double click on the Data Backup Pro application and its startup screen will be displayed.

Registering Data Backup Pro

If you purchased Data Backup Pro from the Internet, you will have been emailed the serial number. When you first start Data Backup Pro, you will be asked to

activate the software. Type the code into the boxes provided, and click the Register button.

Logging in as admin
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The first time you run Data Backup Pro you will be required to enter an administrator password. This precaution is for your own protection. Since Data Backup Pro

has access to all files on your hard drive, the login information is required to verify that you have legitimate access to your computer’s data before allowing you to

copy the data. After the first run you won’t be required to enter your password again. If you want to require a password to be entered on every run, you can turn off

the Retain Authentication preference (see Preferences Section 5).

2.1.1 Select a Default Destination drive/folder

When you first run Data Backup Pro it will look for an external drive (Thunderbolt, USB or FireWire) to set as your default destination. If you have more than one

external drive or if your drive is partitioned, it will pick the drive or partition with the largest amount of free space. If you do not have an external drive, you will be

asked to specify a default destination.

You can change your default destination at any time by selecting the Set Default Destination item from the File menu.

2.2 Select a backup to run.
Next, you need to select the backup you wish to perform. You can do this by selecting the backup type from list of backups on the left side of the main window.

If you have not selected a default destination only the backups to CD/DVD will appear in Data Backup.

By selecting a backup, you are specifying which files to backup and where the copied files will be placed. Data Backup Pro automates this process to help you get up

and running fast. Refer to Data Backup’s information panel to review what will happen in the backup that you have chosen.

You can select from a few options including:

Entire Internal Drive

A complete backup of all the data on the internal drive of your computer, including the system, all applications and documents. By default, your computer’s data will

be copied to the root of your default destination.

All Non-System Files

A backup of all the data on the computer except for the system files. This backup type is identical to Entire Internal Drive above, but all system files are skipped.

All User Files

A backup of all the documents on the computer created by all users of the computer. By default, the data in your computer’s /Users folder will be copied to the root of

your default destination.

All Files

A backup of all the data in your home directory (the person currently logged into the computer), including preferences and documents. By default, the data in your

computer’s /Users/Name folder will be copied to the root of your default destination.

All Document Files

A backup of all the documents in your home directory. This backup type is identical to All Files above, except that all non-document files are skipped.

All Document Files to CD/DVD

A backup of all the documents in your home directory to CD or DVD.

iPhoto and other Pictures to CD/DVD

A backup of all the files in your Pictures directory to CD or DVD.

2.3 Start the Backup process.
Finally, you need to start your backup process. You do this by clicking the Start Now button near the top of the Data Backup Pro window. You will see some activity

near the bottom of the window as the files are being copied to their destination. The actual time the backup will take depends on several factors including how many

files you are copying, and how fast your computer and hard drive are. The backup will complete even if you quit the Data Backup Pro application.

If you are copying to a CD or DVD Data Backup Pro will prompt you to load writable CD or DVD media. Data Backup Pro can backup to either type of media and can

mix CD and DVDs in the same backup operation.

Once your first backup is complete, verify that the files you expect to see in your destination drive/folder are present. You should place the destination drive in a safe

place, away from your computer - that way, if your computer gets lost, stolen, or damaged, you will still have a good copy of your important data.

In order to learn more about using Data Backup Pro, including Scheduled actions and restoring your data in case of emergency, please refer to the Using Data

Backup section of the manual.
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3 Using Data Backup Pro
3.1 User Interface Introduction

The main screen of Data Backup Pro has four different views, selected with the icons in the top bar. The top bar will always be visible and contains status information in the middle.

The three different views are the “Backups” view, the “Dashboard” view, the “History” view and the “Destinations” view.

Backups View

 The Backups view lists all of the defined backup/synchronize sets and allows you to create new sets, modify existing sets, schedule sets, check the status of your backup sets
and view the history for a particular set.

Dashboard View

 The Dashboard view gives you performance information while your backup is running. It also shows all scheduled events and the history for all backups, synchronizes and
restoes in one place.

History

 The history section shows the status of all operation sets by time. You can select a status to view the log file. Please see the log file viewing section for information on the log file
display.

Destinations View

 The Destinations view allows you to browse and restore from backup destinations. The destination view has management functions for destinations, such as removing old
versions and changing passwords. It also allows you to compare files in a backup against other files.

Backing up your data using Quick or Custom Backup types
In Data Backup Pro, you can choose from a number of predefined backup operations, known as Quick Backup types, or you can define your own custom backup operation and save its
settings as your very own Quick Backup type for later use. All Quick Backup types are accessible by clicking on the Quick Backup popup menu near the top of the Data Backup Pro
window. Every backup type, whether predefined or custom, can be started manually or scheduled to occur at any time of your choosing (See Scheduling your backup for later).

3.2 Selecting Predefined Quick Backup types
There are several Quick Backup types predefined in Data Backup Pro, they represent the most common types of backups and are designed in to help you get up and running fast with the
minimum amount of interaction. Please refer to the Quick Start section of this manual for a description of each Predefined Quick Backup type.

To use a Quick Backup’s default behavior, go to the Backups view (click on the icon in the status bar, select the Quick Backup from the list on the left and click Start Now as stated in
Quick Start. However, if you wish to customize the actions performed by any Quick Backup type, select it from the list. As shown here:
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The parameters for the backup will be in the detail view on the right. You may now change your backup parameters, including the destination drive, or even specify certain types of files
that should not be considered for backup. You can create a custom variant of one of Data Backup Pro’s default Quick backup types. For more information on what parameters you can
customize in this way, please refer to Creating custom Quick Backup types below.

Once you begin to customize a predefined Quick Backup type, it becomes a custom type. When you are finished making your changes you can save it by pressing the “Save” button at
the bottom of the screen or by using the File Menu Save Backup Set option (Command + S). If you would like to make a copy, use the duplicate button in the operation set list view or the
File Menu Duplicate Set option (Command + D). If you want to restore the original predefined type, use the File Menu Add Predefined Set option.

Once you have selected and/or customized a predefined backup type, you may choose to initiate the backup now, or schedule it to be performed later. In order to complete the backup
now, simply click the Start Now button near the top of the Data Backup Pro window. Once started the backup process will run unattended. You may even quit the Data Backup Pro
application and your backup will be completed normally.

Do not disconnect your backup drive while a backup operation (or any other access operation) is in progress, as this may damage the data on your drive. For best results, eject the drive
before disconnecting it. If a backup operation is in progress while you attempt to eject the drive, the eject request will be denied and you must try again later.

3.3 Creating Custom Backup types
If none of Data Backup Pro’s predefined Quick Backup types fit your needs or if you have additional backup requirements, you may define your own backup set with just a few mouse
clicks.

To get started, select the New Backup Set option from the File menu or press Command+N. This will create a new, empty backup set and you can start building it by defining your backup
options such as source drive, destination drive, backup method, scripts to execute and files to include or exclude in the backup process. These options are described in the following
sections below.



3.4 Selecting the Source Drive and/or files for your Backup

Near the top of the backup detail panel, you will find the Sources area. You can drag drives, folders, and files into this area to define the items that you want to back up.

You can also push the button to use a standard file selection window to define a file, folder or volume to be backed up.

To remove a source click on the remove icon in the upper right hand corner of the source item.

Any drive or folder in the Sources area indicates that it and all of its contents (including all enclosed folders) are selected for backup.

By specifying multiple source drives, folders, and files in the source drive selection well, either by dragging or by using the plus button, you can specify several items to back up. For
instance, you can specify both your user folder and your applications folder in order to backup the contents of both your user and your applications folders.

3.5 Selecting the destination type

Data Backup Pro supports backing your files up to both volumes, such as an external or network drive, and CD or DVD media.

Backing up to an external drive is the fastest, cheapest and most convenient way of backing up your data. However, an external drive has the same disadvantages that your internal drive
does: it is easily erased and it is vulnerable to being dropped, electrical power surges and mechanical failure.

Recordable CD’s or DVD’s provide a permanent record of your data that is more robust physically and is also easy to leave in a safe location other than where your computer is stored.
Storing your critical data in a so-called offsite location protects your data against catastrophes that might strike your home or place of business such as fire, flood or earthquake.

Unfortunately CD’s and DVD’s hold a very small amount of data (approximately 700MB and 4GB respectively) compared to the size of the average hard disk so it is usually not practical
to backup your entire computer to CD’s or DVD’s (60GB of data translates into about 100 CD’s or 15 DVD’s) and they are quite slow compared to hard drives.

It’s usually best to use CD’s or DVD’s for your important data such as pictures, movies, documents or your iTunes library which you absolutely cannot afford to lose. Make extra of your
important files on CD or DVD’s and store them at an offsite location, somewhere other than where your computer is kept, to get extra insurance against catastrophe.

Use an external drive to keep a complete backup of your system as a Clone or Versioned backup so that you can get right back to where you were in the event of a hard disk crash.

3.6 Selecting the Destination Drive or folder for your Backup



You specify the destination of your backup operation similarly to specifying your source backup drive, however you may only define a single destination location (you cannot make
multiple copies of your backup within a single backup operation).

To use a folder or drive for your backup, first select the Sources/Destination tab in the main panel and then set the Destination Type popup to Volume.

Near the bottom of the Backup Options panel, you will find the Destination drive selection well. You can drag Drives or folders into this area to define the location you wish your data to be
backed up to.

You can also push the button to use a standard file selection window to define a file, folder or volume to use as a destination.

You can remove the backup location by clicking the remove icon. To change the destination, remove the current selection and then set a new one.

3.7 Selecting CD or DVD media for your backup

To us a CD or DVD for your backup, first select the Sources/Destination tab on the left side of the main panel and then set the Destination Type popup to CD/DVD

There are several options that can be set when backing up to CD or DVD.

Multiple sessions per CD

Data Backup Pro allows you to create multiple sessions on a single CD (this release does not support multiple sessions on DVD media). This is useful when trying to do backups of small
amounts of data. You should not use this option when making critical backups. If a later session has difficulties burning it can make the entire CD unmountable and render the previous
sessions on the CD inaccessible.

Split large files

Data Backup Pro can split files that are larger than a single CD or DVD across multiple discs. If this option is turned off and Data Backup Pro tries to backup a file which cannot fit on a
single CD or DVD (depending on which media you have loaded) it will skip the file and not back it up.

In general you should use this option unless you are making copies of files to take to a system which does not have Data Backup Pro installed.

# of copies

Data Backup Pro can make multiple copies of each CD or DVD as it backing up. Set the number of copies to make here.

You might want to make multiple copies to keep one copy with your machine and take another copy to an off-site location for added protection against disasters or to protect against
media failure. The different copies are interchangeable and can be mixed together in any fashion during a restore.

Use media in drive

When Data Backup Pro backs up to CD or DVD media it usually displays a dialog to select the CD or DVD drive to burn to. If this option is set, Data Backup Pro will look for blank or
appendable media in the drives attached to the machine and select the most appropriate one to backup to.

If you have multiple drives with recordable media attached Data Backup Pro will use each of the drives in turn as it needs additional media for the backup. If Data Backup Pro cannot find
any media in the drives it will display the drive selection dialog if possible.

This option is most useful when making a backup set that will be scheduled to run unattended.

3.8 Specifying files to skip or include

One of the most powerful features of Data Backup Pro is the ability to easily specify all of the files that you want backed up. One of the most important aspects of this is the ability to
specify a set of files that are to NOT be backed up in any circumstance.

For example, if you want to backup your entire hard drive except for things you can easily re-install (like applications) you would specify your whole hard drive to be backed up but ignore
all applications.

Data Backup Pro gives you the ability to do this by allowing you to specify files to include and exclude during the backup process.

You can choose to include or exclude files based on several different parameters, or a combination of parameters. Select the Rules tab of the main screen to display the include and
exclude rules for the backup.



 
Setting Backup Rules

In order to be included in a backup a file or directory must match any include rules and not match any exclude rules. If no include rules are specified this is the same as having an include
rule for everything.

If, for example, you wanted to back up all of your JPEG files but not those files in your browser cache, you could create an include rule for files with a .jpg extension and exclude file for
files that have a parent directory of /Users/ /Library/Caches/Safari.

To add an include or exclude rule, you must click on the “Press to define a new rule button” in the section (include or exclude) that you want to add.

You will be presented with a dialog that allows you to specify the rules that describe the files you wish to include or exclude. In this panel, you can specify files based on several criteria as
defined below.
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Name

The name of the file. In this selection mode, you can specify a number of criteria including contains, starts with, ends with, and is.

You type in your parameters in the text box to determine the included/excluded files.

Example: All files whose name ends in ‘txt’ - this would select all text files for inclusion/exclusion.

Size

The size of the file. In this selection mode, you can specify a number of criteria including is less than, is greater than, and is equal to.

You type in your size parameter (number of kilobytes) into the editable text box to set your rule.

Example: All files whose size is less than 300 kilobytes - this would select all files less than 300 kilobytes.

Date Modified

The modification date of the file.

In this selection mode, you can specify a number of criteria including is today, is within, is before, is after and is exactly. You set your desired date or date range in the control provided to
set your rule.

Example: All files whose modification date is exactly Feb 29th, 2004 - this would select all files modified on Feb 29th, 2004.

Date Created

The creation date of the file.

In this selection mode, you can specify a number of criteria including is today, is within, is before, is after and is exactly. You set your desired date or date range in the control provided to
create the rule.

Example: All files whose creation date is exactly Feb 29th, 2004 - this would select all files created on Feb 29th, 2004.

Extension

The extension of the file.

In this selection mode, you can specify is, and is not. You set the desired file extension by typing it into the editable text area of the panel.

Example: All files whose extension is .app - this would select all files that have .app affixed to the end of their file name.

Parent Folder

All files within the specified folder. In this selection mode, you can specify is and is not.

You set the folder by dragging it into the provided well, or by pressing the select button and using a standard file selection window.

Example: All files whose parent folder is /System.

Finder Color

All files that have their Finder color set to the specified color.

3.9 Selecting the Backup Type



The Backup Type defines how the files that are to be backed up will be organized in the destination drive/folder. There different types of organizational layouts depending on what you are
trying to accomplish with your backup and how much flexibility you want during a restore operation.

Data Backup Pro supports six different Backup Types. Their descriptions, warnings and suggested usages are presented below.

Simple Copy

The source drives/folders will be copied into the destination drive/folder. All the selected data is copied along with some hidden information that helps Data Backup Pro manage additional
backup processes in the future.

In subsequent Simple Copy backups, only the changed files will be copied and files that are no longer present in the source drives/folders will be deleted in the destination drive/folder
(this greatly increases the speed of your subsequent backup operations).

The files backed up can be compressed or password protected while being copied to the destination drive/folder (see Additional Backup Options below for more information).

Use this backup method if you need a simple copy of one or many files or folders and do not care to keep older versions of your files.

Clone

Make an exact copy. This process does not add any hidden information and the resulting data will be in the form of a bootable drive if the source is bootable.

You may not select the compress or password protect option for this type of backup. After the clone backup is completed, the destination drive/folder will contain all of the files in the
source drives/folders, with permissions and dates set identically.

This backup type is most commonly used when you are trying to make a complete copy of your bootable internal volume. You can use the resultant clone as a future replacement drive
for your computer, or install the clone drive into an identical computer in order to establish identical configurations for multiple computers (such as in a school lab environment).

Clone backups do not support compression or encryption.

By default, any pre-existing files and folders in the destination drive/folder will be removed during this backup process - i.e. when the backup is complete, only files that

appear in the source drives/folders will be present in the destination drive/folder.

*Mac OS X can only be booted from a volume, not a folder. When you are making a bootable volume with the Clone backup type you must select the volume as the destination, not a

folder within the volume. In addition, the partition format and attachment type of the volume must be the correct type for booting. *

Mac OS X supports 3 different partition formats - GUID Partition Table, Apple Partition Map and Master Boot Record (aka DOS). PowerPC Macintoshes can only boot from

Apple Partition Map formatted drives. Intel Macintoshes can boot from GUID or Apple Partition Map formatted drives, however Apple only officially supports booting from

GUID partition formatted drives. Mac OS X will refuse to install from an Intel Macintosh to an Apple Partition Map formatted drive. Macintoshes cannot boot from Master Boot

Record formatted drives. Many external drives, especially USB drives, are formatted by the manufacturer with the Master Boot Record format. In order to use a drive that has

been formatted this way, you must repartition the drive using Apple’s Disk Utility or another utility with equivalent functionality. Changing the partition type will always erase

all data from the drive as well so exercise caution.

PowerPC Macintoshes can only boot from FireWire external drives. Intel Macintoshes can boot from USB, Thunderbolt or FireWire external drives.

Versioned

Versioned backups are similar to Simple Copy but old and deleted versions of all the backed-up files are stored inside a hidden area within your destination drive/folder. In the first
Versioned Backup, all of the files in the source drives/folders will be copied into the destination drive/folder. When subsequent backups are run, old versions of files are stored in hidden
locations in destination drive/folder. On restore, files from any backup date can be selected for restoration.

The ability to restore any past version of file (or deleted file) by date makes the versioned backup the most commonly used backup method. For best results, the destination drive should
be an attached FireWire drive or network drive (as opposed to removable media).

Any pre-existing files and folders in the destination drive/folder or files that are not part of the backed up data will be removed during this backup process - i.e. when the backup is
complete, only files that appear in the source drives/folders will be visible in the destination drive/folder.

Older versions of backed up data are invisible from the Finder and may only be retrieved with Data Backup Pro’s Restore function.

Synchronize

The Synchronize backup method merges the contents of two drives or folders and places the complete set of data into both the source and destination drive/folder.

Synchronize is used most often when a user has two computers and wants to share work on both computers. For example if you have a computer at work, and a computer at home and
you sometimes take work home to complete, you might synchronize a folder called Documents (which contains all of the files you need to share between home and work) with your
computer at work and an external FireWire drive, then bring the drive home and synchronize the new Documents folder (from the external drive) to your computer at home (in an
additional Documents folder. When you are finished working at home, synchronize Documents folder your home computer with the external drive once more, then take your external drive
back to work. At the beginning and end of each work session (both home and at work), be sure to synchronize - this way, your home computer’s Document folder and your office’s
Document folder will always stay in sync with each other.

If a file is deleted in either the source or destination folder, the file will be removed from the other drive/folder as well. Similarly, if a file is added to either the source or destination
drive/folder, the file will be created on the other drive/folder as well.

Synchronize is a two-way merge. If you want to do a one-way merge, that is to make one folder or volume look like another, use the Clone or Simple Copy backup type.

3.10 Advanced backup types

In addition to the backup types listed above, Data Backup Pro also provides traditional Full and Incremental backups that work the way that IT professionals are familiar with. These types
are hidden in Data Backup Pro until you turn on the Enable advanced Full/Incremental backups on the Backup tab of the Data Backup Pro preferences.

When we talk about Incremental backups in this manual, we are using the term in the old IT manner. Many people today talk about incremental backups where only the files/folder that
have been changed are copied from one volume to the other. All of Data Backup Pro’s backup types are incremental in that manner. Our Full/Incremental backups are a particular manner
of managing the different versions. If the Full/Incremental terminology is not something you are familiar with you probably really want to be using the Versioned backup type.

Full and Incremental backups work together to allow you to backup up the changes made to your data and keep a history of the changes. These backup types are designed to work with
removable media. If you are backing up to a hard drive, the Versioned backup will give you better results. For use with CD/DVD media, Full and Incremental backups give you more
control over when to perform a full backup of your data. When using Full/Incremental backups be sure to perform Full backups on a regular basis for best protection for your data.

Full

A Full Backup will make a complete copy of all of the files and folders present in the source drives/folders. Upon completion, the destination drive/folder will contain an additional folder
named Full-Date, this new folder will contain all of the files and folders that were copied.

The format of date in the full folder name is as follows:

YYYYMMDDhhmmss, where YYYY = Year (i.e. 2004) MM = Month (i.e. 03) DD = Day (i.e. 13) hh - hours (i.e. 22) mm = minutes (i.e. 23) ss = seconds (i.e. 17)



For example 20040313222317 represents the date March, 13th, 2004 at 10:23:17 pm

Unlike simple, clone, and versioned backups, Full Backup does not overwrite any preexisting files present in the destination drive/folder.

Incremental

The Incremental backup is used with the Full backup to make a copy of the files which have been modified and created since the last Full or Incremental backup to additional folders
called incremental - date.

The Full/Incremental backup combo is most appropriate for removable media because it does not require the previous backups to be online to decide which files to copy.

If you run an Incremental backup without doing a Full backup first, the Incremental backup will copy all of your files. An Incremental backup is not a complete copy of your data! Only the
files that have changed or been modified since the last Full or Incremental backup of that volume or folder are copied. Therefore, in order to restore your files you must have the set of
backups starting with your first Incremental or the most recent Full backup and then all of the Incremental backups after that Incremental or Full backup your are starting with. For this
reason it is recommended that your do Full backups regularly, perhaps weekly or monthly so that the number of Incremental backups you have to restore from is limited.

The format of date in the incremental folder name is as follows:

YYYYMMDDhhmmss, where YYYY = Year (i.e. 2004) MM = Month (i.e. 03) DD = Day (i.e. 13) hh - hours (i.e. 22) mm = minutes (i.e. 23) ss = seconds (i.e. 17)

For example 20040313222317 represents the date March, 13th, 2004 at 10:23:17 pm

Unlike simple, clone, and versioned backups, Incremental Backup does not overwrite any preexisting files present in the destination drive/folder.

3.11 Additional backup options
At the top of the backup options section are two special options. These options are for special situations and normally do not need to be used. Both of these options only apply to backups
that you run with the Start Now button and are not saved when you save the backup set and are not saved when a backup is scheduled.
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Do complete scan

This option causes Data Backup Pro to ignore any Fast Start information and do a complete scan of the source(s) to check for changed files. Data Backup Pro monitors the source
volume(s) for changes, but does not monitor the destination. If you have made changes to the destination use this option to have Data Backup Pro correct for any changes you may have
made. Data Backup Pro automatically does a complete scan on every 10th backup.

Create new baseline

This option only appears for Versioned backups to CD/DVD. Versioned backups to CD/DVD’s normally create a new baseline, backing up all files, every 30 backups. If you feel that you
need to create a new baseline immediately (for example you may have lost some of your backup discs) use this option. If you want to precisely control when new baselines are created,
enable Advanced Full/Incremental backups and run/schedule Full backups as you require.

Destination Options

There are four more backup options available for you when defining a backup process within Data Backup Pro. These options are presented in a panel called Destination Options. You
can select and deselect these options at any time while defining your backup operation.

Create New Folder(s)

You may choose this option to create a new folder for each of your source volumes or folders in the destination volume or folder with the same name as the source volume or folder. This
option does not apply to Full or Incremental backups.

If you have multiple sources selected it is automatically selected (and cannot be turned off). It cannot be selected for Synchronization. If this option is selected for a Clone backup of a
bootable volume, the resulting backup will not be bootable.

Missing Items

You may choose one of the methods for handling files and folders that exist in the destination volume or folder that are missing from the source volume or folder (this option applies only
to Clone, Simple Copy and Synchronize).

Leave - do nothing, leaving the old files in place.

Delete - remove the file, permanently

Move to trash - put the file in the Trash to be removed later

Compress files

You may choose this option to minimize the space required for your backed-up files. When “”Compress files”” is checked, all files copied to your destination drive/folder will be
compressed with an algorithm called Gzip.

This standard compression protocol ensures that you will be able to access your backed up data using standard operating system utilities. Even though all files are compressed during
the backup process, you will be able to see the files individually using the Finder, and you will be able to double-click on the backed up files which will cause them to be uncompressed
automatically. Overall, in general, compressed files will have their size reduced by approximately 50%.

Encrypt

You may choose to protect your backup files from unauthorized access by Password Protecting your backup. When Encrypt is check marked, all files copied to your destination
drive/folder will be encrypted with AES-128 algorithm.

This standard is the latest encryption standard approved by the U.S. Government for sensitive documents. Encryption can be used in conjunction with the compression option explained
above. When encryption option is selected, when starting or scheduling your backup, you will be asked for a password which can be used during the encryption process. This password



will be used to encrypt an RSA private key. You can also enter a hint which will be shown when you restore from the backup.

Encrypting a Backup

Encrypted backups are extremely secure. If you lose your password, you will not be able to access the information in your backup.

Please note that once you select an encryption key, it is stored in encrypted format in the destination drive/folder and will be used for all subsequent backups in this backup set. Because
of the secure nature of the encrypted backup, you may not reset this key under any circumstance.

Even though you can see your encrypted files by browsing within the file, you cannot access them unless you restore them from within Data Backup Pro. You will be required to present
your password during the restoration process.

Scripts
Data Backup Pro allows you to execute scripts or applications before and after your backup runs. This functionality can be used to check conditions before backing up, exit applications,
send email notifications and many other uses. Select the Scripts tab of the main screen to view the scripts that will be executed for the backup set you are editing.
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This panel allows you to add and delete scripts, change the order in which they will be executed and edit the arguments for the scripts.

When scripts are executed the following environment variables are set:

Name Description Set before backup is
run

Set after backup is
run

OPERATION_SET_NAME The name of the backup or synchronize set Y Y
OPERATION_SET_ID The internal ID number of the backup set Y Y
SUMMARY_LOG_FILE The path name of the summary log file Y Y
VERBOSE_LOG_FILE The path name of the verbose log file (if verbose logging is enabled) Y Y

DESTINATION The path to the destination volume or folder. This variable will not be set if the destination is a CD
or DVD. Y Y

SOURCE_N The path to the nth source file, folder or volume Y Y

OPERATION_END_STATUS
The status of the backup or synchronize when it finished. 
0 = Finished with no errors 
1 = Finished with errors 
2 = Failed

N Y

OPERATION_NUMBER_OF_ERRORS The number of errors that occurred during the backup N Y
OPERATION_FAILURE_REASON A short description of why the backup failed if the OPERATION_END_STATUS is 2 N Y

Special note on Automator scripts. If you create an Automator Action using the Automator application available in Mac OS X 10.4 and above you must use Save As and select the File
Format Application to use it as a script with Data Backup Pro.

3.12 The backup process

After selecting all of your backup options, you will be ready to start your backup process. When your backup is running, files will be copied from your source drives/folders to your
destination drive/folder. The files copied are defined by selecting your backup options as defined above.

Data Backup Pro copies your files in the background with a hidden system process; this means that you are free to use your computer while your backup is running. In fact, you may even
quit the Data Backup Pro application while the backup is in process. While the backup is in progress, you may hear your drive accessing, or your drive access light blink - this is normal
behavior. You may at any time launch Data Backup Pro to check in on the progress of your backup.

3.12.1 Starting your backup



Once you have completed making your backup parameter selections, you can choose to start the backup process immediately by clicking the Start Now button. The backup process will
begin immediately.

Do not disconnect your backup drive while a backup operation (or any other access operation) is in progress, you may damage the data on your drive. For best results, eject the drive
before disconnecting it. If a backup operation is in progress while you attempt to eject the drive, the eject request will be denied and you must try again later.

If you have made any custom parameter selections, a dialog box will appear, asking if you would like to save your backup settings as a custom backup set or run without saving.

Saving a Backup Set

From this point on, your custom backup set will be available in the Operation Set list. By selecting your named backup set from the Operation Set list and clicking start, you will then be
able to perform your custom backup set at any time in the future without re-selecting any backup options.

3.12.2 CD/DVD backups

When backing up to CD’s or DVD’s you will need to do a little preparation before starting your backup.

First, have a sufficient supply of CD’s or DVD’s available to hold the data you wish to backup. CD’s will hold about 600 MB and DVD’s will hold about 4GB of data. If you are backing up a
large number of small files you will get less data stored per disc.

Second, be organized. Have a marker pen and some way to store the discs handy. Your backup will not be very useful if the discs are all scratched up or you can’t figure out which discs
are part of which backup or you lose some of your backup discs.

You should be aware of what kind of CD/DVD burner you have available. Older Macintoshes may have a drive that can only read and write CD’s or a drive that can read DVD’s but cannot
write them - in this case you will only be able to use CD media.

When a backup to CD or DVD is started, Data Backup Pro will display the following window:

 
Disk Burning

This panel is similar to the standard Mac OS X CD/DVD burn panel but there are a couple of additional pieces of information. It shows the name of the backup that is executing and also
what the volume will be named.

Insert the CD or DVD disc you want to burn to and select the drive you put it into. Then, press the Burn button to burn that volume of the backup.

If you press the Cancel button, Data Backup Pro will ask you if you want to abort the backup.

Data Backup Pro will prompt you with this panel each time it needs another CD or DVD to backup to.

You can display more options by pressing the disclosure button in the upper right. This will cause the panel to display additional options.

 
Disk Burning Options

You can control the speed at which the drive is burning by selecting from the Speed list. Data Backup Pro will automatically pick the fast speed the drive and media are capable of. If you
are having difficulty getting discs to burn properly, try reducing the speed and burning again.

Data Backup Pro will verify the data on the new disc after writing it if Verify burned data is selected. Turning this off will save some time but it is possible for discs to burn correctly but still
have some data be unreadable. We recommend leaving this option on if your data is at all important.

You can select whether to eject the disk when done or leave it in the drive and mount it on the desktop.

3.13 Scheduling your backup for later



Instead of starting your backup immediately, you may choose to schedule the backup to happen at some time in the future. To create or edit the schedule for a backup, go to the Backups
view, select the backup in the list on the left, and then select the Schedule tab.

The Schedule tab displays all existing scheduled backup events for the backup, and allows you to schedule the current backup set in a variety of ways.

 
Scheduling an Event

Every currently scheduled event appears in the Events list near the top of the scheduling options panel. There is an entry for every scheduled event. To review the details of any
scheduled event, see Reviewing your backup schedule below. If there is a scheduled event that you no longer wish to happen, you may click the Remove button near the bottom of the
Events list.

To add a new schedule event, click the “Press to add a new schedule event” button. The Schedule Dialog will appear.

In the Schedule Dialog, select the preferred schedule type (Selected dates, Interval, Selected events, and Days of week), then set your desired parameters for that schedule type. When
you are finished, click the Set”” button. To accept all shown scheduled events in the Events list, save the set, or revert to discard your changes.

The operation of the various schedule types are described in the sections below.

Selected Dates

This schedule type allows you to specify a specific time and date at which to perform your backup. The date you specify can be any date in the future - when this date occurs, your
backup will be performed even if Data Backup Pro is not running at that time.

 
Backing Up On a Date

By clicking the up/down arrows near month, day, year, hour, minute, and am/pm, you can set each of the date time parameters. When you see your desired date and time in the
parameter well, click the add button to commit your schedule date to the events list.

Interval

This schedule type allows you to specify a recurring interval at which to perform your backup. The interval can be specified in minutes, hours, days or weeks. The first backup will be
performed after the interval specified. Your backup will be performed even if Data Backup Pro is not running at that time.

 
Backing Up on Intervals

By clicking the up/down arrows in the left side of parameter well, you can select a number of weeks (up to 4) or a number of days (up to 30). You can set your desired backup time in the
right hand side of the parameter well. Click the add button to commit your interval schedule to the events list.

Selected events

This schedule type allows you to specify a special event at which to perform your backup. The event may be either System Startup time, or at the time the Source or Destination Drive
appears.

 
Special Event Backups

By clicking System Startup, your backup will be scheduled to occur whenever the system starts up. Alternatively, by clicking the Destination Volume or Directory Appearance, your backup
will be scheduled to occur every time your backup destination drive/folder appears on the desktop. This is an especially useful option if you are backing up to an external FireWire drive or
a network drive - every time you mount your destination drive, your backup will occur, even if Data Backup Pro is not running.

Click the add button to commit your selected event schedule to the events list.

Days of week

This schedule type allows you to specify a recurring weekly interval at which to perform your backup. You may specify any day of week and time for your backup to be performed. The first



backup will be performed the next instance of the day of week you selected. Your backup will be performed even if Data Backup Pro is not running at that time.

 
Specific Day Backups

By clicking the boxes corresponding to the days of weeks in the left side of parameter well, you can select the desired days of week for your backup to be performed. You can set your
desired backup time in the right hand side of the parameter well. Click the add button to commit your interval schedule to the events list.

3.14 Monitoring the progress of your backup operation

While a backup operation is in progress, you can monitor the backup activity by launching Data Backup Pro and observing the file copy activity in the status window at the center of the
top bar.
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If you wish to pause the current backup activity, you may do so by clicking the Pause button (the pause button will then become a run button). To restart the backup activity, click the run
button.

If you wish to stop a backup activity, you may do so by clicking the Stop button near the bottom of the window.

For more detailed information, go to the Dashboard View.

Dashboard View

The Dashboard View gives you performance information about the current backup and an overview of all scheduled items.

Performance

To view detailed information about the currently executing backup, click on the Performance tab of the Dashboard.
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The Performance section has three major areas.

Performance Graph

The Performance graph shows the number of files scanned per second, the number of files copied per second and the number of bytes copied per second. You can scroll back to the
beginning of the backup, and zoom in or out on the graph.

Overview

To the left of the Performance graph, an overview of the backup is shown. This includes information such as the number of files selected, the number copied, maximum and current rates
and the start time of the backup.

Copying Information

The bottom part of the Performance section shows the files that are waiting to be copied, the file that is currently copying and the files that have been copied.

Schedule

The Schedule section of the dashboard shows you all schedule events for all operation sets. To change one, click the edit button. To remove one, click the remove icon (graphic goes
here)

Destination View
Destinations are where your backed up data is kept. The Destinations View allows you to restore, manage, compare and view the history for destinations.

Restoring data from your backup

In order to restore information from a previous backup operation, select the Destinations View and select the Destination from the list on the left. If the destination is not in the list, you can
add it by clicking the “+” button below the list and selecting the volume/folder. After selecting the destination, click the Restore tab.



Restoring Files

This screen allows you to select the files to be restored. If the backup destination you selected was a Versioned backup (or a Full/Incremental backup) the Version list will show the dates
of the backups that this destination contains. Select the date you wish to restore from. The Files browser will show you the files that are available in that backup. Initially all files are
selected for restoration. If you want to pick specific files, first deselect all files by clicking on the button in the Selected column for the top level. Then, browse to the files you want to
restore and select them.

When you select a file, information about it will be displayed on the left.

After you have selected the files you want to restore click the Restore button. A sheet will drop down to select your restore destination and options.

 
Restore Destination

This is the final screen before the restore is run. Click the button to select the volume to folder to restore to or drag a folder or volume into the sheet. When Create a new folder to restore
to is selected a new folder with the name of the source you are restore will be created and all files will be restored inside of that folder. This is the safest way to restore files and will not
overwrite or delete any files that already exist in your destination volume or folder. Sometimes you may wish to restore a volume or directory to the state it was in when you created the
backup. In those cases, uncheck the Create a new folder to restore to option. If you are trying to make a bootable volume by restoring from your backup you will also want to turn this
option off.

If there are files in the Restore destination that match the names of files in the Restore source, the existing files in the destination will be overwritten. Files that are exist in the restore
destination but not the backup will be handled according to your setting - Leave will not delete them (however, if the same file exists in the backup the file will be overwritten with the data
from the backup), Delete and Move to Trash will handle them the way specified.

After you have selected the restore destination and device on the restore options you are ready to begin the restoration process - simply click the Restore button and the files will begin to
be copied to the Restore destination.

Managing Versioned backups
When Data Backup Pro performs a backup set that utilizes the Versioned backup type, the destination drive/folder will contain hidden areas in which old versions of files are stored. The
only way to remove these old versions of files is to manage the versions from within Data Backup Pro. These can be removed automatically (see Preferences - Backup) or you can
remove them manually.

To manage your backed up data’s versions, go to the Destinations view, select the destination you wish to manage from the Destination list on the left and then select the Manage tab.

The list of versions in your backup will appear. You can remove the oldest version by clicking the “Remove Oldest Version” button in the lower right (if there is only one version shown, you
cannot remove it - that would leave you with no backed up data).
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Removing backup destination information

Data Backup Pro stores information about the destination in the backup folder/volume for most destination types (it does not store any extra information for Clone backups). Sometimes
you may want to change the way a volume is organized, for example, if you have been using the volume as the destination and wish to make several folders to use as destinations. In
order to do so, you must remove the destination information. To do so, go to the Destination view, select the destination, go to the Manage tab and press the “Remove Destination Info”
button. This will remove the hidden backup information.

Changing the password for a destination

To change the password, go to the Destination view, select the destination, go to the Manage tab and press the “Change password” button.

Comparing your backup with the source

If you would like to see what changes have occurred between your backup and the source, you can do so by using the destination compare function. Go to the Destination view, select
the destination and go to the Compare tab. You may select the folders/files to be compared and, if you have Versioned backup, you may select the versions to compare against. Once you
have selected the files/folders and version to compare, press the Compare button. You will be asked to select a file/folder to compare against. Once you have selected and pressed the
Compare button, the compare will begin running. A compare results window will appears and be updated until the compare completes.
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4 Managing Data Backup Pro
4.1 Creating, deleting, renaming and duplicating backup sets

To create a new, empty backup set click the + sign below the operation setlist, use the File->New Backup Set option, or press Command-
N.

To delete a set, select it from the Operation Set list and click the trash can icon below the list or use the File->Delete Backup Set option or
press the delete key (you will be prompted to confirm the deletion before the set is deleted)

To rename a set select the set from the Operation Set list, change the name in the details panel and then save the set.

To duplicate a set, select the set from the Operation Set list then press the duplicate icon below the operation set list, use the File-
>Duplicate Backup Set option or press Command-D

4.2 Editing backup sets

You can edit any backup set by selecting it in the Operation Set list and then making the desired changes.  
When you are finished making your changes you can either save them using the File->Save Backup Set option (Command-S) or click the
“Save” button in the lower right hand corner of the details section. To discard your changes, click the “Revert” button.

4.3 Adding Predefined Sets

When Data Backup Pro is first configured it automatically creates a set of predefined backup sets for you. If you need to recreate those
original predefined sets you can use the File->Add Predefined Set option to

To add a predefined set, select the predefined set you would like to add and click the Add button. If a set with the same name already
exists the set you are adding will be named #1. If you do not have a default destination set you will only be able to add the sets that use
the CD or DVD drive as a destination. To set a default destination, use the File->Set Default Destination Option.

4.4 Managing the Quick Backup List

To change the order of the sets in the Quick Backup List, click and drag the set to the desired position in the list .

4.5 Reviewing your backup schedule

To see all scheduled items, go to the Dashboard, then click on the schedule tab. By selecting Schedule from the view menu, you can
open the schedule review window. Here you can view the description of every scheduled backup operation and you can edit or delete
scheduled items.
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4.6 Viewing Data Backup Pro Log files

During the backup process, Data Backup Pro creates log files that report any errors encountered during the backup process and
additional information depending on the logging level that has been selected.

A log file is generated for each backup or restore operation. You can find log files of interest in several different sections.

If you are looking for log files for a specific backup, go to the Operation Set Info view and select the backup you want to see the log files
for. Select the History tab and you will see a list of logs for that backup set. Select the log that you are interested in and it will appear in
the log display section.

You can also see a list of all logs, ordered by date. Go to the Dashboard view and select the History tab. Select a log file and it will
appear in the log display section.

Log files can also be accessed by the destination they are associated with. Go to the Destination view and select the History tab. Select a
log file and it will appear in the log display section.

Log Display

Data Backup Pro allows you to easily browse through log files. Log files may be viewed with messages organized by the file they are
associated with, or by the phase of the backup they are associated with.

Message Level

In the upper left corner of the log display section you can select the level of messages to display. Each log message generated by Data
Backup Pro has a level of importance attached to it. From least important to most important, those levels are:

Debug Very detailed message to help debug problems
Info Informational message. Does not need any action
Notify Important information.
Alert Important message that may require action. For example, an error that occured when backing up a file
Fatal An error that caused the operation to stop

Initially, it is set to “All” which will display all levels. Selecting other levels will show messages at that level or higher in importance (for
example, selecting “Alert” will also show “Fatal” messages).

By default, Data Backup Pro will only log messages of the Notify level or more important. To have Info and Debug level messages
logged, enable Verbose Logging in the preferences.



Browse by file

Select the File tab in the log display section. The tree browser on the left shows files that have messages associated with them. Selecting
a file will show messages associated with it. If you select “Show Descendant Messages”, if you have selected a folder, messages for any
files or folders contained by that folder will be shown also. If you select “Show messages for selected file only” only messages for that file
or folder will be shown. The browser will only shows files that have messages associated with them.

Browse by phase

Data Backup Pro splits a backup into four phases.

Preflight Getting ready to do the backup
Scanning Scanning the source(s) for files and folders to be backed up
Copying Copying the files and folders selected in the scanning phase (usually overlaps the Scanning phase)
Postflight Tidying up after the backup has finished

Select the By Phase tab to view the log messages by phase. Initially, “All” is selected which will show the messages from all phases,
ordered by time. You can select an individual phase to show the messages associated with that phase.

Exporting log files

If you would like to edit a log file, or send it to someone else, you can export it as a text file. Click the “Export” button in the lower right
hand corner of the Log Display section and select a file to save it into.

Other log files

Data Backup Pro has other log files that are stored as text. To access these, select “Text Log Files” from the View menu.

Data Backup Pro Desktop Backup

From the log review window, you can choose to view several different types of logs by selecting the type of log desired from within the
view popup menu. You can select a specific log indicated in the central list within the window by clicking on the log entry. To open a
selected log and view its contents, click the Open button near the bottom of the window.

The types of logs you can choose from include:

Executor
logs

This is a very technical log that indicates the internal functioning of Data Backup Pro during all backup processes. These
logs contain information primarily of use to Prosoft Engineering, Inc.’s technical support department in the event that you call
in reporting a problem while using Data Backup Pro.

Application
logs

These logs contain information about the internal functioning of the Data Backup Pro user interface. These logs contain
information primarily of use to Prosoft Engineering, Inc.’s technical support department in the event that you call in reporting
a problem while using Data Backup Pro.

Summary This log file reports all the backup tasks in general, including how many files were copied during the backup process. If an
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Backup
logs

error occurred while backing up a file, the error will be reported here. These will only be created if “Create text log files” is
enabled see the Preferences section).

Verbose
Backup
logs

This log file is similar to the Summary log above, but it includes much more information, such as the path to every file copied
during the backup process. These logs are created only if the Create verbose logs preference in turned on (see the
Preferences section) as well as “Create text log files”. All file copies are reported in this log regardless if there was an error
or not. Note that this log file can become very large if a large number of files are being backed up.
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5 Preferences
5.1 General
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Display times in AM/PM or 24 hour format

This controls the display of times in the Data Backup Pro application. Select Display times in AM/PM format to have

times displayed with AM/PM times. Select Display times in 24 hour format to have times displayed in military style,

24 hour format (e.g. 8:00 PM is displayed as 20:00)

Browse as System Administrator

Normally Data Backup Pro browses files as the current user. This works well for most uses. If, however, you are

trying to select another user’s files to backup you may need to browse as system administrator.

Retain authorization

After you have authenticated for the first time, Data Backup Pro retains that authorization so that you do not need

to enter your password every time you run the Data Backup Pro application. If you are working in an insecure

environment and want Data Backup Pro to require authorization every time, turn this option off.

Check for updates when application starts

If this option is selected, Data Backup Pro will automatically check with the Prosoft web site for updates to the

software whenever the application is started.

Wake up for scheduled events

Data Backup Pro can wake up the machine from sleep or power off to run backups that you have scheduled. This

option controls whether Data Backup Pro will wake up the machine when it is turned on or sleeping, only when it is

sleeping, or never.

5.2 Backup
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Automatically remove old versions (Versioned backups)

When you use Data Backup Pro’s Versioned backup feature, old versions of files are kept in your backup directory.

These can be removed by using the Manage Versions item from the File menu or you can set them to be removed

automatically. If the Automatically remove old versions option is selected Data Backup Pro will only keep as many

versions as you specify (any number greater than 2 can be specified). When a Versioned Backup is run, Data

Backup Pro will first remove as many old versions as necessary to have the specified number of versions.

Enable advanced Full/Incremental backups

The Full/Incremental backup types while useful to IT professionals are often confusing for regular users. Select this

option to make them available to use.

Overlap scanning and copying

When selected, Data Backup Pro begins copying files as soon as they are found during the backup process.

5.3 Logging
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Create verbose logs

When Data Backup Pro performs a backup it creates log files recording what it did and what errors, if any,

occurred. By default, a summary log file only is created. If you would like a more verbose log file, detailing exactly

which files were backed up or skipped, turn this option on. You can select Verbose as the log level, or Debug which

will produce even more information about the internal workings of Data Backup Pro. Note: Verbose log files can be

quite large (100’s of megabytes).

Clean old log files automatically

This controls the removal of old log files automatically. If this option is turned off, log files should be removed

manually, especially if verbose logs are being kept as they may fill your system disk. Data Backup Pro removes old

log files at system startup and every night at midnight.

Create text log files

Data Backup Pro uses a binary log format to enable easy viewing of the log files with the log display window. Data

Backup Pro can also automatically generate text log files that can be used by other tools. Select this option to

generate text log files.

5.4 Notifications

Data Backup Pro provides a number of options for notifications when backups complete. Notifications can come via

the Data Backup Pro application, through the OS X notification center and via email.
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Show status on successful completion

When a backup completes Data Backup Pro displays a status message on a sheet. If this option is not selected

Data Backup Pro will only display that message if an error occurs. This is useful for users who have backups

scheduled to run frequently.

Use Notification Center

Show notifications in the OS X Notification Center when backups complete (requires OS X 10.8 or higher)

Launch application to show status

Data Backup Pro executes backups in the background. This option controls when Data Backup Pro will launch the

application to display status. It can be set to never, when backups fail and always.

5.5 Notifications

Data Backup Pro allows you to send email notifications when backups begin and end. Notifications can be sent as

regular email messages and as SMS messages
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Send email notifications

Data Backup Pro can send email when your backup has started and finished. The email will come from

donotreply@prosofteng.com.

System ID

This will be in the message so you can identify which system the notification is from.

Send to

Email addresses to send notifications to. Multiple email addresses can be entered, separated with commas.

SMS Phone Number

Phone number to send SMS notification to (optional). Data Backup Pro currently supports sending SMS messages

to AT&T, Sprint, T-Mobile and Verizon. Normal text messaging rates will apply to these messages. Log files will not

be included in the SMS message.

for failures only for errors or failures always at finish

Controlling when email notifications are sent

Select “Backup starts” to send notifications when the backup begins. Select one of the options for when to send

notifications when backups complete. “always at finish” will always send notifications when the backups complete if

it was successful or if there were errors or failures. “for errors or failures” will only send notifications when there

were errors or failures. “for failures only” will only send notifications when there were too many errors or the errors

were so severe that the backup failed.

Info to send

Select whether to just send a summary (Backup passed/had errors/failed) or select the level of log messages to

include in the email notification (verbose or debug logging must be enabled to receive the verbose or debug level

messages in the email).

Log file limit
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The maximum amount of log file data to include in the email notification. Many email systems have limits on how

large an email can be received so if you set this limit too high and a backup fails with a large number of error

messages you may not receive the notification.

Send test email/SMS now

This will send a test notification immediately to the addresses specified.
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6 Special Concerns
6.1 Tips

Backing up to removable media

You may backup to any removable medium (such as a zip drive). For best results, divide your backup into

manageable portions that fit into a single medium and select the incremental backup option. After your initial

backup (which may consume several mediums), your future backups will only include those files that have changed

since your last backup (generally, this will fit into a single medium).

File size limitations

Many backup utilities have limitations in how many files and/or the largest file that may be backed up. There is no

such limitation in Data Backup Pro.

Volume formats supported

Data Backup Pro supports most volume mountable volume formats (i.e. if you can see the drive on your desktop,

Data Backup Pro can access it).

Moving files during a backup process

If you move files while they are currently being backed up, you may experience unpredictable results. If you move

the file into a directory that has not yet been backed up, the file will appear in its new location, however, if you move

the file into a directory that has already been backed up, the file will be missed and not backed up. If you move a

file that is actively being backed up, some data from the file may not appear in the backed up data (specifically the

resource fork if the destination volume is HFS).

Removing a target backup volume during a backup operation

You should not attempt to remove drives that are currently being accessed (it is possible to lose data by doing this).

If you try to remove a volume that Data Backup Pro is currently using, you will be warned that the volume is in use -

if you ignore the warning and remove the volume anyway, the backup will fail. The failure will be noted in the

backup log.
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7 Support/FAQ
If you have trouble using Data Backup Pro or have questions about using this software, please contact Prosoft
Engineering Technical Support. Full contact information for the support team is available at:
http://www.prosoftengineering.com/support

7.1 FAQ

What are the numbers at the end of the folders created by Data Backup Pro during a Full
or Incremental backup?

They represent the date that the backup occurred. It has the following format:

YYYYMMDDhhmmss, where YYYY = Year (i.e. 2004) MM = Month (i.e. 03) DD = Day (i.e. 13) hh - hours (i.e. 22)
mm = minutes (i.e. 23) ss = seconds (i.e. 17)

For example 20040313222317 represents the date March, 13th, 2004 at 10:23:17 pm

The time and date used is Greenwich Mean Time, not the time in your local time zone.

Will my files that are in use be backed up?

The data present in the file (on the drive) at the time of the backup will be copied to the destination drive/folder,
meaning that changes made after the file is copied will not be backed up until the next backup.

What if the backup won’t fit onto my external drive?

Data Backup Pro only splits files across CD’s or DVD’s. You have the ability to select either drives or folders to be
backed up, select folders that will fit on your destination volume for best results.

Can I back up to a network volume?

Yes, all mountable network volume types are supported, however, if you are backing up to a file server that does
not support permissions (such as AFP volumes), all resultant files in your backup will be owned by the user who
mounted the volume at the time of the backup.

How do I backup a Mac with Data Backup Pro?

Data Backup Pro is an intuitive and customizable Mac backup tool. Backing up your Mac is easy with Data Backup
Pro, just pick your backup type, select your source and destination drives, then hit start. You can even set a
schedule so it backs up your Mac for you on the dot.

How does Data Backup Pro compare with the other clone tools that are available?

Data Backup Pro is a much faster and efficient option when it comes to cloning your mac. We use an intelligent
backup system that will determine if you’ve made changes to your source. If you’ve made changes, then the next
time you run a clone, it will only backup those changes,

What are the types of backups can I create within Data Backup Pro?

Clone – Making a clone of your drive is creating an identical bootable image of your hard drive. This kind of backup
comes in handy because, with a clone of your current drive, in the event where your drive becomes unreadable or
fails, you can boot from the clone that you have created. The drive has to be partitioned with the right partition map
(e.g. GUID/APM). Making a clone of your drive can turn out to be an absolute lifesaver!
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Versioned – A versioned backup is very similar to the simple copy except the old and deleted versions of the
backup will be stored inside a hidden area with your destination. All of your files in the source will be copied to the
destination. When future backups are run, old versions of the files are then stored in hidden locations on within the
destination. Similar to Time Machine, files from any backup date can be selected and restored.

Simple Copy – A simple copy is a basic backup of your drive that includes some hidden information that can help
Data Backup Pro manage additional backup processes in the future. The key feature that makes simple copy the
fastest is that only the changed files will be copied and files no longer present in the source will be deleted in the
destination. When scheduled this is a incremental backup also.

Synchronize- A Synchronize backup method merges the contents of two drives or folders and places the complete
set of data into both the source and destination. If a file is deleted or added in either the source or destination, the
file will be deleted or added from the other.

I cannot boot to the Clone backup I created, why?

Make sure the clone backup was done directly to your destination drive or partition on the drive, the Clone backup
cannot be done to a folder. Also, if you are using an Intel based Mac make sure that your destination drive is
formatted GUID. You can do this through Apple’s Disk Utility.

I am backing up to a network drive, I noticed when the backup is done there are a lot of
errors, why?

Under Destination Options, make sure you have “Missing Items” set to Leave or Delete and Not “Move to Trash”.

Can I back up to a network volume?

Yes, all mountable network volume types are supported, however, if you are backing up to a file server that does
not support permissions (such as AFP volumes), all resultant files in your backup will be “owned” by the user who
mounted the volume at the time of the backup.

What’s new in Data Backup Pro?

A new and improved user interface to make customizing your backups quick and easy.

Text and email notifications to let you know when your backup is done, even when you’re on the go.

Improved performance and bug fixes.

Optimization for OS X versions 10.7.5 and up.

What if the backup won’t fit onto my external drive?

Data Backup Pro only splits files across CD’s or DVD’s. You have the ability to select either drives or folder to be
backed up, select folders that will fit on your destination volume for best results.

What versions of OS X does Data Backup Pro Support?

Data Backup Pro supports Mac OS X 10.7.5 and up.

How do I create a bootable clone of my hard drive? How can I clone my external drive
onto a clean internal hard drive?

First you need to make sure that the drive formats on your external drive exactly match the format of your internal
system drive, in other words if you have journaling enabled on your internal boot drive it must be enabled on the
external drive. We advise not making any changes to your internal boot drive, but make the changes on the
external drive. You also need to check the partition scheme and make sure it is appropriate for your system:

Intel Mac’s should use the GUID partition scheme
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PLEASE NOTE: Also, when you launched Data Backup Pro, you need to create a new backup set by going to File
—> New Backup Set and then configure the new backup set for Clone. This makes sure that there are no other
options in the background that would prevent the destination volume from being bootable.

When cloning the internal drive to external, make sure you select the Internal volume as the Source, and External
drive as the Destination.

Data Backup Pro installs with several pre-existing backup sets (pre-configured backup rule sets) that help you to
get going faster, but Clone is not one of the pre-configured backup set types.

Therefore you need to create a new backup set to perform the Clone operation.

What encryption technique is used in Data Backup Pro?

Files are encrypted AES-128 (Advanced Encryption Standard, aka Rijndael). This is the latest encryption standard
approved by the U.S. Government. RSA public/private key encryption is used to encrypt passwords.

I’ve restored my XYZ application, but I’ve lost my serial number and the vendor tells me I
have to purchase a new license? How can I restore the serial number?

You should look in both of the two following locations on the backup drive:

/Users/[Home]/Library/Preferences

-and-

/Library/Preferences

for the appropriate PLIST file for your application, and then copy it back to the same location on your primary hard
drive as it was found residing in on your backup drive.

NOTE: The first file location may be located in the Users Library Folder which is hidden, You can temporarily
access this folder by opening a Finder Window and pressing Command+Shift+G. This will “Go to the folder”, enter
in “~/Library” and click go.
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